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Introduction 
 
Acrobat Reader Files (PDF) do get indexed by search engines and they can do well in the search 
engine results.  

 
PDF = Portable Document Format. 

 
 
In this document we’ll cover - 
 

• Tips to better rankings & click-throughs from search engine result listings for your PDF’s. 
 

• Including active links within PDF’s to increase the number of readers who visit your web site 
or contact you.  

 
Active links within a PDF also give search engines paths to find content on your web site 
and may improve search rankings. 

 
• How to analyze the results of online PDF’s using analytics. 

 
 
 
 
NOTE - You are free to republish this PDF or pass it along as long as you retain the PDF in its 
entirety with all its active hyperlinks. 
 

 
 

 
 
 

by:  
 

George Aspland 
eVision, LLC 

179 East Main Street  
Branford, Connecticut USA  06405   

203 481.8005  •  sales@eVisionSEM.com •  www.eVisionSEM.com 

 

 
 

mailto:sales@eVisionSEM.com
http://www.eVisionSEM.com
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Better rankings & click-throughs  

Make sure your PDF includes mostly formatable text  
Here’s an example of PDF file that was indexed in Google. It’s a special issue from Scientific 
American that was put up on a government web site. 
 
Whoever put this PDF up scanned the entire issue in from a hardcopy (This is not unusual. We see 
many PDF’s that are scanned from hardcopy).  
 
Here’s a screenshot of a partial page from this 9 page PDF: 
 
 

 
 

A PDF indexed in Google.  
The entire document was scanned in from a hardcopy 

 
While this is an extreme example of including all the text in a document within images it will help 
emphasize the issues of not using formartable text. 
 
Here are some of the problems when you scan a document from hardcopy: 
 

• The entire PDF is made up of solid, one page images so it’s huge, many times larger than it 
needs to be. 

http://www.eVisionSEM.com
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• Because the text is scanned it’s very hard to read, almost illegible. 
• Most importantly, search engines can not read the text within this PDF 

 
Below is a search engine listing for this PDF in Google:  
 

PDF] pdf file 
File Format: PDF/Adobe Acrobat - View as HTML 
Page 1. Page 2. Page 3. Page 4. Page 5. Page 6. Page 7. Page 8. Page 9. 
snap.lbl.gov/news/ScientificAmerica_special_Issue_0904.pdf - Similar 
pages 

 
Notice the description Google created for this file, “Page 1. Page 2. Page 3. Page 4. Page 5. Page 
6. Page 7. Page 8. Page 9.” This happened because there was no text in the PDF that Google 
could read and index. Google could not read the text in the PDF so it could not create a more 
meaningful description. 
 
This listing is not going to help “entice” people to click-trough to this document and it will not help 
this document rank better unless somebody is searching for “Page 1”. or “Page 2”. etc – Sidebar: 
There were over 200,000 results for this search in Google - "Page 1. Page 2 Pdf”. 
 
Compare the above listing to a Google search results listing for a PDF from our site for a search on 
“improve conversion rates”: 
 

 
 
Google created the following listing from the text contained within the PDF by creating snippets 
from phrases it found within the document that contains the words and/or the phrase being search 
on: 
 

“How can Conversion Point Architecture. Design. increase my leads. and sales?” Successful 
websites are all about improving your conversion rate.” 

 
Whenever possible make sure your PDF is created using a method that keeps most of the text as 
regular formatable text so that the search engines can read and index it. 
 

How to tell if the text is formatable text - 
You should be able to tell what text in your pdf is formatable text by selecting some amount of the 
text (the method to do this will vary depending on the application and version of the application 
you’re using to read the PDF). If you can select sections of text, such as individual words or 
phrases, and copy and paste this text into another application such as a text editor, then it is 
formatable text. 
 
Another way to tell if the text in a PDF is formatable text is to Export it if your application offers this 
feature. If you can export the text into a format that allows you to use the text in other application 

http://www.eVisionSEM.com
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and reformat this text, then it’s formatable text. For example if you can export the text into an .rtf 
(Rich Text Format) file then the text is formatable text. 
 
If it’s important that your PDF does well in search results, if needed, you should consider rebuilding 
the PDF to ensure that it includes mostly formatable text. We’ve done this for clients who have been 
given the rights to reprint articles etc but the articles were only available in hardcopy. We scan or 
export all the images and rebuild the article using formatable text. 
 

Optimize the text in the document 
If you are writing or editing the document that will become an online PDF you should optimize it just 
as you would a regular HTML web page and include important keyword phrases in the body and 
headlines etc. 
 
Below, again, is the listing for a PDF from our site for a Google search on “improve conversion 
rates”  

 
 
The occurrences of the phrases “improve/improving conversion rates” as well as sub phrases such 
as “conversion rates” and the individual words “improving”, “conversion” and “rates” throughout this 
document undoubtedly helped the listing reach a higher position in the search results for this 
search. 
 
Also notice how Google extracted snippets of text that included the phrase, sub phrases, and words 
being searched on to build this description for the search listing (just like Google does for regular 
HTML pages). Google also highlighted the words being searched on within the description – 
 

“How can Conversion Point Architecture. Design. increase my leads. and sales?” 
Successful websites are all about improving your conversion rate. 

 
A description that includes enticing phrases with the keywords being searched on highlighted 
should encourage more people to click through to the PDF.  

Update the Document Title 
If possible include a good keyword-rich selling message as the document title. Most search engines 
will attempt to include the PDF’s document title as the headline link for the search listing.  
 

http://www.eVisionSEM.com
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Below is a Google search engine listing for the special issue from Scientific American: 
 
 

PDF] pdf file 
File Format: PDF/Adobe Acrobat - View as HTML 
Page 1. Page 2. Page 3. Page 4. Page 5. Page 6. Page 7. Page 8. Page 9. 
snap.lbl.gov/news/ScientificAmerica_special_Issue_0904.pdf - Similar pages 

 
 
Here is the Document Properties for this PDF (detailed instructions to update the Document 
Properties using Acrobat 7.0 standard follow):  
 
 
 

 
 

Acrobat 7.0 Document Properties Window 
 
 
In this case there is no document title so Google displayed “pdf file” as the headline.  
 
The headline, “pdf file”, is not going to help entice people to click through to the document or help it 
rank for any meaningful keyword searches. 
 

http://www.eVisionSEM.com
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How to update the Document Title 
Access to the document title will depend on the tool used to create the PDF. Very often a utility will 
be available from the application’s toolbar under the File command where you can update the 
document title. Try looking for commands under “File” such as Documents Settings or Document 
Properties. 
 
You can also update the Document Title if have a version of Acrobat that allows you to modify the 
document properties, such as Acrobat Standard or Acrobat Professional (I have not seen a version 
of Acrobat Reader that allows you to update the document properties).  
 
It’s actually best to update the Document Title using a version of Acrobat that allows you to modify 
the document properties because many applications automatically modify the document title they 
create. For example Word 2003 ads “Microsoft Word –“ in front of the document title you create 
(Note - To modify the Document Title in Word 2003 select File / Properties). 
 
In Acrobat (the development tool. Not the free reader) you can usually access the document title as 
follows: 
 

File > Document Info > General, or 
File > Document Properties > Summary 

 
 
Try to include a good keyword-rich selling message as the document title. Below is the Google 
search result listing for a PDF from our site for a search on “improve conversion rates” – 
 

 
 
The Document Title is the highlighted link in the search result listing: 
 

Improving Conversion Rates with Conversion Point Architecture Design 
 
Just as with regular HTML pages, because the phrase being searched on, in this case “improve 
conversion rates” is in the document title this listing reached a much higher position in the search 
results than it would have if the phrase was not in the title. 
 
Also notice how Google highlights the words and phrases being searched on within the document 
tile (as well as the file description it extracted from the text within the document). 
 
The combination of a well written document title with the words and phrases being searched for 
highlighted should help entice people to click-through to look at the pdf document. 
 

http://www.eVisionSEM.com
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Link to the PDF 
To get the PDF indexed in search engines add one or more links to it from pages on your web site, 
preferably on pages that are already indexed themselves and that are not too deep within your site.  
 
The same link popularity analysis appears to apply to PDF’s as it applies to regular HTML pages. 
For competitive keyword phrases you’ll want to apply the same techniques as you would for a 
regular web page such as including links to the PDF from other pages both on and off your web site 
(more on link popularity later). 
 

Increase web site visits from a PDF 
Now you’ve got your PDF ranking better and people clicking through to it from search engine 
listings, let’s look at how to improve the click-throught rates for a pdf (that is getting people to 
contact you or go to your web site where they may convert into leads or sales). 
 

Add contact info  
Make sure the document includes all your contact information including your web site 
address, email address etc, so that people will know how to reach you and your web 
site whether they read the PDF online or print it out.  
 

Include active hyperlinks to your web site 
Place a links(s) to your web site and email links within the PDF so that people may contact your or 
click through to your site while online. 
 
These active links within a PDF also give search engines paths to find content on your web site and 
may improve search rankings of the pages they point to. So include links in PDF’s that you host on 
your web site and on PDF’s you distribute to others such as datasheets, whitepapers, manuals and 
instructions, articles etc. 
 
Here’s a PDF being viewed within a browser with no active links to the web site anywhere within the 
PDF: 
 

http://www.eVisionSEM.com
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A pdf with no active links 
 
There’s no way for any one to click through to the web site if they view this PDF online. In fact the 
address to the web site isn’t in the PDF at all (this is not unusual). 
 
Here’s a search engine listing for a PDF on our web site. 
 

 
 

 
When searchers click through to the pdf from this listing most will see the following pdf in their 
browser: 
 

http://www.eVisionSEM.com
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A pdf with active links 
 
 
Notice the hyperlink at the top of the page, www.eVisionSEM.com. It’s an active link to our web site 
(The logo is also an active link to the web site. More on this later). 
 
 
Below is a screen shot of the last page of this two page PDF: 
 
 

 
 

Active links throughout the PDF 
 
The links to the web site and the email address at the bottom of the PDF and within the body of the 
pdf are all active links. This PDF includes plenty of opportunities for people to click through to the 
web site or send us an email. 
 

http://www.eVisionSEM.com
http://www.eVisionSEM.com


Increase web site visits from a PDF                         www.eVisionSEM.com  •  11 

Active Links when PDF is viewed as HTML 
Most search listings for PDF’s include an option to view the PDF as a web page. Here’s a search 
engine listing for a PDF on our web site again. Notice the View as HTML link: 
 

 
 

Option to View as HTML in Google SERP 
 
I don’t know how many people actually view pdf’s this way. This feature does a terrible job, but 
here’s the above PDF viewed as HTML: 
 

 
 

A PDF Viewed as HTML in Google 
 
 
Again when viewed as and HTML it’s pretty horrible, but at least the embedded hyperlinks work and 
people will likely click through to the web site. 
 

http://www.eVisionSEM.com
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How to convert URL’s into active hyperlinks in a PDF 
The way to imbed active links within a PDF will vary depending on the tool used to create or modify 
the pdf. Some tools may allow you to specify that you want web addresses to be active in the pdf 
that is created. If the tool you’re using does this, great. However we’ll make the assumption that 
you’ll layout your document using a tool, such as Word, and save it as a pdf without the web 
addresses automatically being converted to active links. We’ll show you’ll how to turn the web 
addresses into active links using the Acrobat development tool (Acrobat Standard 7.0 in this case). 
Note - I’ve seen Word to Acrobat tools turn URL’s into active links automatically at times, but often it 
does not or it doesn’t do all the URL’s. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Create links from URLS using Acrobat 7.0 Standard 

 
1. Export your document as a PDF 
2. Open the document with Acrobat  
3. Choose Advanced > Links > Create from URLs in Document (see image below)  
4. In the Create Links Dialog window either select All or enter a range of pages and click OK. 

 
 

 
 

Choose Advanced > Links > Create from URLs in Document 
 
 

Tip:  Highlight your Links  
Acrobat 7.0 Standard will not change the text color to 
blue or add an underline when it converts the text 
URLs to active links. 
 
As you lay out your document, highlight your web and 
email addresses so they will standout as active links. 
Ideally use the expected blue color text and consider 
underling the text too, e.g.  www.domain.com 

http://www.domain.com
http://www.eVisionSEM.com
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That’s it. Acrobat will convert all the web and email addresses it detects within the text of your PDF 
into Active hyperlinks. 
 

How to turn any text or image into an active link 
In addition to converting URLs to links you can turn just about any text or image in a pdf into active 
hyperlinks. This gives you the flexibility to turn any text within the body of your document into an 
active link. You can also incorporate a navigation system similar to that found on a web site 
allowing you to provide links to pages in a site without having to include long URL’s within your 
PDF. 
 
Below is a screenshot of the top portion of a PDF we created for a client: 
 
 

 
 

A PDF with text and image links 
 
In addition the active web address in the banner, the phrases “Home”, “Site Map”, and “Contact” are 
links to pages on the web site as is the logo in the banner. This banner looks very similar to the 
banner on the client’s web site. 
 
Using the Acrobat tool (Acrobat Standard 7.0 in this case) here’s one method to turn just about any 
text or image into an active hyperlink. 
 
 
Create text and image links using Acrobat 7.0 Standard 
 
1 Go to the page in the PDF where you want to place the link.  

2 Choose Tools > Advanced Editing > Advanced Editing Tools / Link Tool.  

 

http://www.eVisionSEM.com
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Choose Tools > Advanced Editing > Advanced Editing Tools / Link Tool 

 

3 Drag a rectangle around the area you want to define as a link. When you release the mouse 
button, the Create Link dialog box appears.  

4 Click the Open a Web Page radio button in the Create Link dialog box.  

 

 
Link to the Web by choosing  

Open a Web Page button in the Create Link dialog box. 

 

5 Click the Next button and the Edit URL dialog box appears. In the Address field, type the URL of 
the website to which you want to link and click OK.  

 
Enter a URL for the link. 

 
 

http://www.eVisionSEM.com
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PageRank and PDF’s 
The same link popularity analysis (Link Pop, PageRank, whatever you want to call it) appears to 
apply to PDF’s as it applies to HTML pages.  
 
Here’s an example – 
 
In a Google Search of the acronym “pdf”, the listing below was the 4th listing in the search results 
from among 140 million results - 
 
PDF] 2007 Form W-4 - 2 visits - Nov 10 

File Format: PDF/Adobe Acrobat - View as HTML 
Form W-4 (2007). Purpose. Complete Form W-4 so that your. employer can withhold the 
correct federal income. tax from your pay. Because your tax situation ... 
www.irs.gov/pub/irs-pdf/fw4.pdf - Similar pages 

 
This is the IRS’s PDF of the W-4 form.  
 
The first two listings in the results are pages from Adobe’s web site that mention PDF multiple times 
in the pages. The third listing is an article all about PDF’s in, of course, Wikipedia. 
 
However the PDF of the W-4 tax form doesn’t mention the acronym “pdf” anywhere within the 
document or in the Document title (however the folder where the PDF is hosted does contain “pdf” 
in the name: pub/irs-pdf/) 
 
Here are some link popularity indicators about this PDF –  
 

Google backlinks: 363 
Incoming Yahoo Links: 7,276 
Incoming Alexa Links: 12,886 
Google Toolbar PR of 7 
Rand’s SEOmoz Page Strength 6/10 
 

It appears this PDF is reaching top results primarily because of the links pointing to it. 
 
In our experience we don’t see lots of PDF’s reaching top positions for meaningful competitive 
searches. This likely has to do with the link popularity of most PDF’s, they typically are not linked to 
as much as HTML pages, this is especially true of internal site linking.  
 
However as you can see from the above example some PDF’s do attract many links. Here’s 
another example.  

Tip:  You can add parameters to your links  
 
Consider adding unique URL’s or adding tracking 
parameters to the URL’s so you have more tracking 
options with your analytics (there’s more about 
analytics later). 

http://www.irs.gov/pub/irs-pdf/fw4.pdf
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In a search in Google on the phrase “Improving Conversion Rates” the organic listing in the 3rd 
position is a PDF. It’s not ours though.  There’s an HTML page from our site on page two of the 
results. Our PDF is not within the first three pages of results. I added a couple of more links 
(November 14, 2007) to our PDF including one from our site map. Let’s see if that helps. 
 
In summary, PDF”s do well enough in search results especially for less competitive searches. And 
again, the links within the PDF’s do get crawled which can get new content indexed and may help 
improve the rankings of the pages pointed to (more on this in the next section). 

Do PDF’s pass PageRank? 
We suspect PDF’s PageRank just like an HTML page, but let’s do a test. 
 

Legal Stuff –  
 
You are free to republish this PDF or pass it along as you wish only if you retain the PDF in 
its entirety with all its active hyperlinks. 

 
Ok, so you can post this PDF on your web sites or pass it along to others. Let’s watch the effect it 
has on some charity sites. 
 
Life Haven, www.lifehaven.org  is a temporary shelter that provides a safe and nurturing 
environment for less pregnant women and women with young children.  
 
I setup their original web site some years ago. They’ve since redesigned it (apparently with little 
concern for search results!). 
 

Here are some link popularity indicators about www.lifehaven.org   
 

Google backlinks: 6 
Incoming Yahoo Links: 118 
Incoming Alexa Links: 11 
Google Toolbar PR of 5 
Rand’s SEOmoz Page Strength 2.5 / 10 

 
 
The New Haven/León Sister City Project, www.newhavenleon.org is a progressive, binational, 
grassroots organization that fosters a relationship between the communities of Greater New Haven 
and León, Nicaragua 
 
 

Here are some link popularity indicators about www.newhavenleon.org 
 

Google backlinks: 6 
Incoming Yahoo Links: 30 
Incoming Alexa Links: 12 
Google Toolbar PR of 4 
Rand’s SEOmoz Page Strength: 3.5 / 10 
 

http://www.lifehaven.org
http://www.lifehaven.org
http://www.newhavenleon.org
http://www.newhavenleon.org
http://www.eVisionSEM.com


Analyzing PDF Search Results                         www.eVisionSEM.com  •  17 

A few months after this PDF is published I’ll check to see if there have been changes to the link 
popularity. 
 

Analyzing PDF Search Results 

You can analyze the search results of online PDF documents on your web site using advanced web 
site analytics.  
 
In this section we’ll cover some techniques using Click Tracks by analyzing the pdf’s on the 
eVisionSEM.com web site. 
 

Determining the PDF landing pages on the site 
To see data about the PDF’s on our site that were landing pages (i.e. the first points of entry to our 
web site) I setup an Advanced Label in Click Tracks.  
 

Labels in Click Tracks are very similar to Goals in Google Analytics except that you can have 
up to 50 active Labels. Plus Click Tracks will compile historical data for a new label on the fly so 
you don’t have to wait for data to build up to see results. 
 

 
To setup the Advanced label: 
 

• Select “Entered at a certain page” in Advanced Visitor Labeling 
 

• Then choose any pages that “Contains the String”: 
 

.pdf 
 

• Give the label a name such as “PDF entry to site” 
 
 
In the Site Overview report you’ll find a list of the Top Entry Pages for the label. 
 
Below are the pdf’s on our site that have been landing pages or entry points to our site: 
 
Top Entry Pages 
  PDF entry to site     
/documents/Conversion_Point_Architecture_Design.pdf 78.8% 41
/documents/w3_award_evision.pdf 7.7% 4
/documents/Conversion_Point_Architecture_Design_press_release.pdf 5.8% 3
/marketing/clicktracks/clicktracks_click_fraud.pdf 5.8% 3
/marketing/clicktracks/clicktracks6.pdf 1.9% 1

 

http://www.eVisionSEM.com
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You can see there are five PDF’s on our site that have been entry pages to the site. The 
Conversion Point Architecture PDF we have used as an example throughout this document is the 
most active PDF landing page. 

Search phrases used to find the PDF’s 
In the Click Tracks Site Overview report you’ll find a list of the Top Search Keywords that were 
searched on to find the PDF’s on a site. 
 
Here’s a list of some of the keyword phrases used to find the PDF’s on our site. You’ll see many of 
them are from searches I did. 
 
Top Search Phrases - 
  PDF entry to site 
evision conversion rates   
pdf site:evisionsem.com   
site:evisionsem.com pdf   
improving conversion rates site:evisionsem.com 
conversion point architecture 
download architectural site plans 
architectural design.pdf   
web design conversion points 
percent conversion point   
point of selected site(architecture) 
architecture conversion   
build your house connecticut usa 
lead to sale conversion graphic 
fraud analytics in india   
architecture design.pdf   
architectural design rates   
"@evisionsem.com"   
increasing conversion point 
conversion point   
what is a architectural design storyboard 
"architecture design.pdf"   
"conversion point"   
conversion architecture website design 
click fraud filetype:pdf   
architecture design process .pdf 

 
 

Analyze click-throughs from an online PDF 
To try to analyze the click-throughs from an online PDF into the web site I setup a combination of 
Click Tracks Labels. 
 
First I setup a Label to track visits to any HTML page on the site: 
 

• Select “Entered at a certain page” in Advanced Visitor Labeling 

mailto:"@evisionsem.com
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• Then choose any pages that “Contains the String”: 

 
.htm 

 
• Give the label a name such as “View HTM page” 

 
• Then setup another label. This time choose the “Combination of other Labels” type of Label. 

 
• Select both the “View HTM page” and “PDF entry to site” labels  

 
• Give this combination Label a name such as “ PDF & Deeper” 

 
 
The data for this combination label should be listing data about visitors who entered the site via a 
PDF and then went further into the site and viewed one or more regular HTML pages. 
 
From the Site Overview / Top Entry Pages, Below are the pdf’s on our site that have been entry 
points to our site where people then clicked though from the PDF to other pages on the site 
 
PDF’s generating Click-throughs  
  PDF & deeper  
/documents/w3_award_evision.pdf 
/documents/Conversion_Point_Architecture_Design.pdf 

 
It makes sense that only these two pdf’s have resulted in people clicking through to other pages our 
site. Two of the other three pdf’s that were found in search results are Click Tracks documents that 
do not include embedded links to our site (Hmm. It might be worth looking into adding links to our 
site on these PDF’s in the future). The third PDF was a press release that has not been optimized 
for click throughs. 
 

Pages visited after viewing the PDF 
Once the above “PDF & Deeper” combination label has been setup we can see a chart of the top 
pages our site that were visited after the people clicked through from the PDF to our site.  
 
Here are the top pages on our site that were visited after people clicked through from the links 
within our online PDF’s -  
 
Home page 
/clients.htm   
/blog/category/conversion-point-architecture/ 
/blog 
/blog/2007/01/ 
/blog/2006/12/ 
/blog/2007/06/ 
/blog/2007/03/ 
/blog/2007/04/ 
/marketing/seopakcages.htm 
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/jobs.htm 
/blog/category/search-engine-marketing/ 
/about.htm 
/blog/2007/02/ 
/marketing/clicktracks/clicktracks6.pdf 
/marketing/submissions.htm 
/marketing/payperclick.htm 
/blog/ 

  

Paths from PDF’s to specific pages 
If the active links in an online PDF are getting clicked on quite a bit you may see the approximate 
numbers of clicks for a time period reported in the Previous Page section of the Path View within 
the Navigation report for a specific page. 
 

Click-Throughs from PDF”s on other sites 
If you have PDF’s hosted on 3rd party web sites that include Active Links to your site, such as 
datasheets, whitepapers, etc, you should see the approximate numbers of clicks for a time period 
reported in the Top Referrers chart within the Site Overview (you may need to increase the number 
of Top Referrers displayed). You should also see data in the Previous Page section of the Path 
View within the Navigation report for a specific page. 

Time on Site and Page Views 
With the two Advanced Click Tracks Labels setup (the “PDF Entry to site” and “PDF & Deeper” 
labels discussed earlier) we can look at time on site and Page Views per visit. 
 
As an example, below is the Time on Site and Page Views per Visits numbers for the two labels 
compared to the numbers for all visitors to our site and for all Search Engine visitors to our site. 
There’s not enough data from the online PDF’s to analyze in a meaningful way yet. 
 
 
Time on site 
All visitors 30s
Search Engines 26s
PDF entry to site 48s
PDF & deeper  797s

 
 
 
 
Page Views per Visitor 
All visitors 1.7
Search Engines 1.4
PDF entry to site 1.6
PDF & deeper  9.5
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About George Aspland 
George founded eVision in 1998 and has been developing and optimizing web sites for large 
and small companies and organizations around the world since. He speaks regularly on the 
subject of Search Engine Optimization and has written a book on the subject, The Guide to 
Search Engine Marketing, a step-by-step guide to search engine marketing used by 
organizations who wish to optimize their own web sites.  
 
Aspland also writes an online marketing blog/newsletter, which is sent to webmasters and 
marketing executives. Visit the blog to sign up for the newsletter, www.evisionsem.com/blog. 
 
About eVision 
eVision has been providing design and online marketing services to clients around the world 
since 1998. We drive targeted traffic to a web site through legitimate search engine 
optimization (SEO), pay-per-click (PPC) search engine marketing tactics and online promotion 
while working to ensure the web site turns those visitors into inquiries, qualified leads, and new 
business. 
 
At eVision we build traffic to our clients’ web sites and then make sure that traffic converts into 
leads and sales. By focusing on these two strategies at the same time, we turn our clients’ sites 
into “sales machines”. We know how to drive traffic to a web site, and once visitors arrive, we 
know how to keep them there to follow your calls to action and convert them into leads and 
customers.” 

eVision was selected as the Silver Winner in the Professional Services category for the 2006 W³ 
awards by the International Academy of Visual Arts and the W³ - The World Wide Web 
Consortium.  

 
 

eVision, LLC 
179 East Main Street  

Branford, Connecticut USA  06405   
203 481.8005  •  sales@eVisionSEM.com •  www.eVisionSEM.com 

 

  
 

http://www.evisionsem.com/blog
mailto:sales@eVisionSEM.com
http://www.eVisionSEM.com
http://www.eVisionSEM.com

